GETTING STARTED WITH ARTICULATE STUDIO
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Oriented</td>
<td>4</td>
</tr>
<tr>
<td>Creating Your First Project</td>
<td>6</td>
</tr>
<tr>
<td>Enhancing Your Slides</td>
<td>7</td>
</tr>
<tr>
<td>Adding an Engage Interaction</td>
<td>13</td>
</tr>
<tr>
<td>Recording an Instructional Video with Replay</td>
<td>19</td>
</tr>
<tr>
<td>Adding a Quizmaker Quiz</td>
<td>25</td>
</tr>
<tr>
<td>Publishing Your Course</td>
<td>32</td>
</tr>
</tbody>
</table>
Welcome to Articulate Studio ’13! This guide will get you up to speed on using Articulate Studio ’13 to create great e-learning, quickly and easily.

If you have more questions, tap into the superpowers of the Articulate community by asking a question on the E-Learning Heroes forums or reviewing our in-depth product tutorials. We’re here to help!

Now, let’s get started. In this guide, you’ll learn how to:

• Get oriented with the software
• Create your first project
• Enhance your slides with multimedia
• Add interactivity with Articulate Engage
• Record an instructional video with Articulate Replay
• Add a quiz with Articulate Quizmaker
• Publish your course
Getting Oriented

Articulate Studio ’13 includes four applications: Articulate Presenter, Articulate Quizmaker, Articulate Engage*, and Articulate Replay. Articulate Presenter is a PowerPoint plugin that you can access from the Microsoft PowerPoint ribbon. You’ll do most of your authoring work right in PowerPoint, then use Articulate Presenter to enhance your slides with things like narration, media, and characters.

You can also access Articulate Quizmaker and Articulate Engage from the Articulate tab. Articulate Quizmaker makes it easy to build quizzes, surveys, and other assessments, so you can test whether learners have mastered key content. Articulate Engage lets you create interactions that keep learners interested by simply filling out a form.
The fourth application in the Articulate Studio ’13 suite is Articulate Replay, the easiest way to create a training screencast with webcam. While you can’t launch Articulate Replay from the Articulate tab, you can insert Articulate Replay videos with just a few clicks.

Now let’s jump into how you can quickly create your first project with these products.
Creating Your First Project

Launch the Software

Articulate Presenter makes it easy to create courses within the familiar PowerPoint environment. To get started, you’ll need to launch PowerPoint by double-clicking the PowerPoint icon on your desktop.

Create a Project

The first step in creating an Articulate Studio ’13 project is building your slides in PowerPoint using all the PowerPoint tools, such as text boxes, pictures, and shapes. You can get a jump start on creating a compelling visual look by applying a PowerPoint design theme or downloading free templates from E-learning Heroes.

You’ll want to save your work to your local hard drive. Working on a network drive or external drive (such as a USB) can cause erratic project behavior.
Enhancing Your Slides

Once you have basic content on your slides, it’s time to transform them into a course using Articulate Studio ’13. Simply click the Articulate tab to start adding rich e-learning elements. Let’s take a quick look at how you can easily enhance your slides with video, characters, and narration.

Insert a Video

Videos are a great way to show learners how to do something—whether it’s using new software or selecting the right workplace safety gear. They’re also useful for adding personality to your course. Watching someone you can relate to is usually more interesting than reading a list of bullets.

You can add an existing video to your Articulate Studio ’13 project from a video file or a website. To add a video file in virtually any format, click the Video button on the Articulate tab, select Add Slide Video from File, browse to the video you want to use, and click Open. A window will pop up that gives you some great playback choices. Click OK when you’ve got it configured just right.
It’s just as easy to add a video from a website such as YouTube, Screenr, or Vimeo. First, you’ll need the embed code. Don’t worry, it’s easy to find. Here’s how:

- **YouTube:** Click the **Share** link under the video, click the **Embed** link, then copy the code provided in the expanded box.
- **Screenr:** Look for “share this screencast” to the right of your video. Click inside the **Embed** box, then copy the code provided in the pop-up window.
- **Vimeo:** Click the **Share** button that appears when you hover your mouse over the video player, then copy the code in the pop-up window.

With the embed code in hand, click the **Video** button on the Articulate ribbon again, but this time choose **Add Slide Video From Website**. Then
paste the embed code into the **Insert Video from Website** box and click **Insert**. You’ll get the same nifty playback configuration options. Click **OK** when you’re all set.

---

**Add a Character**

People love people; we’re social creatures. So if you want your learners to connect with course material, include characters in your e-learning. The good news is that you don’t have to hunt online for characters. Articulate Studio ’13 comes with more than 45,000 photographic and illustrated characters, expressions, and poses. You can insert them right from the **Articulate** tab.
Click the **Character** button, then select **Illustrated** or **Photographic**.

Choose a character with the expression and in the pose you want, then click **Insert**.

Use the buttons at the top and lower right to customize your character’s expression, pose, and perspective.
Narrate Your Slides

Narration is a great way to enhance your visual content and engage your audience. You can record narration in Presenter all at once or slide by slide, reading from the PowerPoint notes pane to keep you on track. Just click the **Record Narration button** to open the recording panel.

Narration is recorded for the selected PowerPoint slide.

You’ll be able to read your script in the notes pane while you record.
When you’re ready, click **Start Recording** and then start talking! Presenter will record till you click the pause or stop button. When you want to move to another slide, click the right arrow on the recording pane. When you’re all done, click **Save & Close**.

Click the arrows or drop-down to move to another slide...

...or Save & Close if you’re done
Adding an Engage Interaction

The best courses transform your learners from passive viewers to active participants. And there’s no quicker way to do that than with the polished, professional interactions you get with Articulate Engage ’13. You can easily build any of the 20 different media-rich interactions by filling out the intuitive interaction forms in Engage.
Create a New Interaction

Create a new interaction as a slide in your project by clicking the Engage Interaction button from the Articulate tab and then clicking Create New. When you see the New Interaction window, choose the interaction you want to create, enter an Interaction Title, and click OK.
Note that the **Interaction Title** you enter here will be shown in the course player menu and used as the interaction file name.

**Add Text**

To add text to your interaction, select a step from the **Steps** panel, then enter your text in the large center panel. You can easily format your interaction text using the formatting tools available on the ribbon directly above the text input panel.
Add Media

You can add one image, character, video, or Flash file to each step of your interaction via the Media panel on the right side of the screen as seen above. After inserting your media, use the Position and Size drop-downs to select your preferred display options.
You can also add impactful audio to your interaction by importing an audio file or recording your own narration. To import an audio file, click the **Import audio file** button, browse to the file you want to use, and click the **Open** button. Or, if you prefer, you can click the **Record** button to capture your own narration.
Add an Engage Interaction to a Presenter Project

When your interaction is ready, click **Save and Return to Presenter**.

Your Engage interaction will be inserted as a new slide in your Presenter project.
Recording an Instructional Video with Replay

You’ll be amazed at how easy it is to make a lasting impression on your learners by recording an instructional video with Articulate Replay. By recording your screen activity and webcam at the same time, you can give your audience the crystal clear instruction they need, along with the personal connection they want.

Create a New Project

Articulate Replay is a stand-alone application. To get started, you’ll need to launch Replay by clicking the Replay icon on your desktop. When open, click the New Project button from the launch screen.
Prepare to Record

A little preparation can go a long way toward creating a professional-looking instructional screencast. Here are a helpful few tips.

• Create an outline or script for your topic to avoid making mistakes while recording.
• Find a quiet, distraction-free location.
• Close any unnecessary programs such as email, instant messaging apps, or anything that could pop up onto your screen while you’re recording.
• Open any applications you want to capture in your recording.

Launch the Recording Tool

You can start your recording by clicking the Record Screen button on the Replay ribbon.
Set Recording Options

After the recording window appears, select a **Microphone** option, set the size of the recording area, and select a capture size for your webcam if you’re using it.

Articulate Replay makes it easy to choose a recording size by offering the two most popular recording sizes and a custom option. In most cases, the default sizes will work great in your projects.

Start by choosing the recording size that matches the proportions of your PowerPoint slides: **720 x 540** (4:3) for standard PowerPoint slides or **720 x 404** (16:9) for widescreen PowerPoint slides.

If you’re not sure what size your PowerPoint slides are, just click the **Slide Size** button on the **Design** tab in PowerPoint 2013.
When you need to record an area of the screen that’s larger than the default dimensions, you can easily resize the recording box. Just click and drag the resize handle in any corner of the recording area. That way, your screen recording area maintains the proper width-to-height ratio to match your PowerPoint slides.

If you want to include video from a webcam, select a capture size that matches your slides and the screen recording area as detailed above.
Record & Publish a Video

When you’re ready, click the red **Record** button. When you’re finished recording, click **Done**.

To publish your video, click the **Publish** button, browse to the location where you want to publish, name the file, and click **Save**. Replay compresses and encodes your video into MP4 format, which can be easily inserted into your Articulate Studio ’13 projects.
Insert a Replay Video into a Presenter Project

To insert your Replay video into your project, click the Video button on the Articulate tab, select Add Slide Video from File, browse to the Replay video you created, and click Open. Choose your playback options, then click OK.
Adding a Quizmaker Quiz

When you want to know whether learners are mastering your material, an Articulate Quizmaker ‘13 knowledge check is the perfect tool for the job. The 25 different question types in Quizmaker make it easy to build exactly the quiz you want.

Create a New Quiz

To create a new quiz as a slide in your project, click the Quizmaker Quiz button from the Articulate tab and click Create New. Enter the title of your quiz and click OK.
Import Questions

You can get a headstart on building your quizzes by using existing questions from a database or tapping your subject matter experts to author questions for you. Just import them from an existing quiz, an Excel spreadsheet, or a text file.

Insert a Multiple-Choice Question

Let’s take a look at how you can build one of the most common assessments: a multiple-choice question.

To add a new multiple-choice question to your quiz, click Graded Question on the Home tab, select the Multiple Choice question type, and then click the Insert button.
When the **Form View** opens, type your question into the space provided and enter your answer choices below. Be sure to select the radio button indicating which answer choice is correct.
Insert a Freeform Pick-One Question

Freeform questions are a great way to transform ordinary slide content into interactive questions. We’ll show you a pick-one question here, but you’ll also want to explore the other types of freeform questions, including drag-and-drop, pick many, text-entry, and hotspot.

A freeform pick-one question is like a multiple-choice question, but instead of using text as answer choices, you can use objects such as pictures, characters, shapes, and captions.

To add a freeform pick-one question to your quiz, click Freeform Question on the Home tab, select the Pick One question type, and then click the Insert button.
When the Slide View opens, add at least two objects (pictures, characters, shapes, etc.) to the slide that can be used as answer choices.

Next, switch to Form View to identify the objects you want to use as answer choices by clicking the drop-downs in the Choice column. And don’t forget to use the radio buttons to mark the correct answer.
Set the Passing Score

To set the passing score for your quiz, switch to the **Question List View** and click **Quiz Properties** on the **Home** tab. On the **Quiz Info** tab of the Quiz Properties window, adjust the percentage learners must score to pass your quiz.
Add a Quizmaker Quiz to Presenter

When your quiz is ready, click the **Save and Return to Presenter** button on the Home tab. Your quiz will be inserted as a new slide into your Presenter project.
Publishing Your Course

When you’re ready, the final step is to configure the course player and publish your slides for delivery to your students.

Customize the Player

Presenter wraps your content in a course player. While the default player configuration works great for many projects, you can easily customize the player interface surrounding your slides to create the perfect frame for your content.

With Presenter, you control the color scheme, navigation settings, display and location of the player elements, and more. Just go to the Articulate tab and click Player.
When the **Player Properties** window appears, you can customize just about any part of the player—and even save all your changes to share with others or reuse in another project.

### Preview Your Course

You can easily preview your slides any time you want to take a quick look at the changes you’ve made to your content without publishing. While most content will display the same when previewed as it does when it’s published, there are a few items that are unavailable when previewing, such as web objects, videos inserted from websites, and hyperlinks.
To preview your course, go to the Articulate tab and click the drop-down arrow below the Preview button. Then select your preferred preview option.

Publish for the Web

If you don’t need to track learner completion, you can give learners access to your course by publishing it for the web.

You’ll just click Publish, then choose Web. Select whether you want to include HTML5 and Articulate Mobile Player output, then click the Publish button.
If your organization has a learning management system (LMS), be sure to get instructions from your LMS administrator on publishing your course.
E-Learning Heroes Community

Now that you’re up to speed on the basics, we encourage you to explore our E-Learning Heroes community often. It’s the place to get fast answers to your e-learning questions, step-by-step tutorials for building better courses, advice and opinions from industry experts, and lots of free downloads for your projects.
If you enjoyed this guide, please feel free to link to it from your own site or share this link on social networks.